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SB200a Specifications 

Maximum layer count 64+ 
Via rules Conventional, blind and buried 
Materials library Foils 

RCC foils 
Cores 
Pre-Preg 
Solder mask 
Ident 
Peelable mask 
Coverlay 

Post press compensation Yes (user defined) 
Finished thickness compensation Yes 
Cu thickness calculation Yes 
Board thickness calculation Yes 
User library Yes 
Save builds Yes 
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Personal Computer Requirements 

Computer IBM PC AT or compatible 
Processor Pentium 1GHz or better  

Operating system Windows 98 Microsoft Windows NT, 
Windows 2000 SP4/XP  

Environment Latest .NET framework installed 
System memory required 128MB recommended 
Hard disk space required 200MB (min.) 
Video standard SVGA (1024 x 768 min.) Hi color 16 bit 
CDROM drive  

Mouse Microsoft compatible 
Licensing Fixed: Parallel/USB key 

Floating FlexLM licence 
(Windows and Linux servers only) 
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Guide To The Manual 

Introduction Introduces the Polar Instruments SB200a. 
Installation/set up Instructions for installing/uninstalling and activating 

the SB200a software. 
Using the SB200a  Discussion of the SB200a user interface; creating 

and editing stackups. 
Adding controlled impedance 
structures 

Working with the Si8000 to add controlled 
impedance structures to the stackup model. Using 
the goal seeking facilities of the Si8000 to obtain the 
correct impedance for a structure. 

The SB200a Materials libraries Using the SB200a materials libraries, creating new 
libraries, adding material to the library. 

Design rule checking Using the SB200a Design Rule Checker to correct 
stackup design errors. 
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Introduction to the SB200a 

The SB200a Stackup Design System 
The Polar SB200a PCB Stackup Design System is designed 
to reduce the amount of time consumed in PCB stackup 
documentation and control. The SB200a offers both 
interconnect designers (PCB layout engineers) and PCB 
front-end engineers a fast and professional solution to layer 
stackup creation. The SB200a is both graphical and easy to 
use while providing formal documentation for everyone 
involved in ensuring the correct materials are used in the 
build process. 
The SB200a allows the user to view stackup in 2d or 3d 
format. Layer and material annotation is clear and easy to 
read and each layer may be selected and queried to display 
the associated material type and properties, including the 
associated data file. Visible drill information ensures that 
designers instantly know which layers support conventional, 
blind and buried vias.  

Integration with the Si8000 
The SB200a is fully integrated with the Si8000 Controlled 
Impedance Quick Solver so the user can quickly add 
controlled impedance structures to layers in the stackup. 
Using the Goal Seek facility of the Si8000 the designer or 
board fabricator can rapidly arrive at the controlled 
impedance structure parameters to produce the target 
impedance. 

Materials library 
The SB200a supports a flexible materials library. This allows 
the designer to use standard materials data, and also 
provides the facility to create new material libraries. PCB 
fabricators can also build libraries of commonly stocked 
materials to give interconnect designers visibility of materials 
held in stock. 

Preferred builds 
PCB fabricators are able to create and share preferred 
builds and exchange this information with designers. Build 
information also includes blind and buried via information. 



 

2  •  SB200a PCB Stackup and Construction Builder  

This simplifies the task of sharing stackup and drilling 
information between board shops and the design 
community. 

Dimensional information 
Finished thickness is a critical dimension in many 
applications, the SB200a keeps track of finished thickness 
and tolerance, and allows fabricators the flexibility of adding 
in house post press thickness for pre preg layers. 
Additionally the SB200a takes into account plating thickness 
where appropriate. 

Graphical interface 
The SB200a offers an easy to interpret graphical interface. 
Clearly showing the layers supporting blind and buried vias, 
the SB200a also records the data file for each layer 
(including ident and peelable mask layers). The graphical 
interface is especially designed to simplify the process of 
communication between interconnect designer and 
fabricator. OEMs who need to manage boards sourced from 
multiple suppliers will also find this facility invaluable. In 
addition to physical layers the SB200a adds mask and 
notation for electrical layers. 
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Installing the SB200a 

Activating the SB200a 
Activation will depend on the license purchased. It will be 
necessary to activate the product license prior to performing 
calculations with the SB200a. The SB200a is licensed using 
the FlexLM License Manager via a license file on a license 
server or the local machine or a software key connected to 
either the parallel port (typically LPT1) or a USB port. The 
FlexLM licensing files should be installed and running on a 
locally accessible server (the server must be running to 
manage licensing) or on the local machine for a node-locked 
license.  

Licensing the SB200a using FlexLM 
When the first stackup build is performed the SB200a 
FlexLM License finder asks for the name of the License 
Server or License File. 

 

Ensure the Specify the License File option is selected and 
press Next. 

Activation using a node-locked license 
Enter the name of the license file or browse the local 
machine to locate the license file and press Next. 

Activation using a license server 
Enter the name of the license file or browse the network to 
locate the license file and press Next. 
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The name of the license server will normally be the Network 
Identification name of the computer acting as the Licensing 
Server. 

 

The SB200a will perform stackup builds within the terms of 
the license purchased. 

Installing the software key 
If a software key is used insert the key into the parallel 
printer port or USB port; if required, plug the printer cable 
into the software key. Locate the license file as described 
above. 
Note: If installing the software key on a Microsoft Windows 
NT or Windows 2000/XP system it will be necessary to be 
logged on as Administrator. 

Uninstalling the software 
To uninstall the SB200a software click the Windows Start 
button and choose Settings and Control Panel. 
Double-click Add/Remove Programs and choose SB200a 
from the list. Click Remove. 
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Using the SB200a Stackup Design 
System 

The SB200a Stackup Design System 
Double-click the SB200a icon to start the SB200a program. 
The main screen is displayed. 

 
The SB200a screen comprises: 

• The menu bar — drop-down menus containing all the SB200a commands 

• The tool bar — incorporating short cut tool buttons to the most common 
menu commands 

• The stackup build and construction window — where the board stack up 
is built and edited 
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• The Controlled Impedance window displaying the controlled impedance 
structures (if any) for the selected layer. 

• Stack Up Notes/DRC (design rules check) — a free form text area for 
explanatory or commentary notes/DRC 

• Stack Up Information properties area — table containing information 
related to the whole stackup. 

• Selected Item Information area — properties table containing the 
attributes of the layer currently selected in the stackup 

The SB200a Menu System 

The File menu 

 

The File menu allows for creation of new stackups and 
projects, opening, saving and printing existing stackups and 
projects. 

Saving stackups 
Click the Save button to save the stackup. Users are 
recommended to save the stackup frequently during the 
stackup creation process to avoid data loss. 

Saving projects 
Stackups that incorporate controlled impedance structures 
are saved as projects. Use the Save Projects command to 
save a stackup and its controlled impedance structures; 
projects are saved as .sci files. 

Printing stackup information 
To print the stackup information, choose the Print… 
command from the File menu. Choose Print Preview to 
examine the stackup information prior to printing. 

Exporting stackup information 
The SB200 incorporates the facility to export the printed 
output in Gerber, DXF and CSV formats. From the File 
menu choose the Export To command and choose the 
format from the Export To sub-menu. 
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Backing up stackups and libraries 
Stackup files (assigned the .stk extension), project files 
(assigned the .sci extension) and library files (assigned the 
.mlb extension) should be backed up to a secure location. 

The Edit menu 

 

The Edit menu contains most of the commands necessary 
to create and modify board stack ups. The 
designer/fabricator works within the free-form stackup build 
and construction window and adds layers of core, prepreg, 
foil, etc., from the materials library. 
Layers can be changed to signal, plane or mixed, moved up 
or down or copied and pasted, or assigned properties as 
required. 
The SB200a will apply design rules to the finished stackup 
to ensure compliance with good board design, (for example, 
the SB200a will check for symmetrical layers, misplaced 
layer types, adjscent copper layers, etc.) 

The View menu 
The View menu allows the SB200a to display the stackup in 
a 2-dimensional or 3-dimensional aspect. 
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The SB200a toolbar 
The SB200a toolbar comprises shortcut links to the most 
popular commands. 

 
Pause the mouse over each tool button to display the tool’s 
screen tip 

File operations 

 Create new stackup 

 Stackup Wizard 

Adding layers to the stackup 

 Add layer to the stackup 
Click to select the layer type. The list of layer types is 
displayed in the associated sub-menu. 

 

Layers available include: 
Foil… Add foil layer to the stackup 
Prepreg… Add prepreg layer 
Core… Add core layer 
Soldermask… Add solder mask 
Coverlay… Add Coverlay layer 
Ident… Add screened ident layer 
Peelable… Add peelable mask 
RCC… Add resin coated copper layer 

 Add mechanical/laser drill between layers 
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Editing the stackup 

 Delete selected stackup layer or drill 

 Swap selected material 

 Copy material of the selected layer 

 Paste material above selected layer 

 Paste material below selected layer 

Set the selected electrical layer as a signal layer 

 Set the selected electrical layer as a plane 

Set the selected electrical layer as a mixed 
signal/plane layer 

 Move selected layer up one layer 

 Move selected layer down one layer 

Display properties dialog for the selected layer or 
drill 

Changing the stackup view 

 Display 2-dimensional view 

  Display 3-dimensional view 
Managing the materials library 

 Display materials library 
Exchanging data with the Si8000 

 Copy controlled impedance data to Si8000 

Paste controlled impedance data from 
Si8000 
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Configuring the SB200 
From the Tools menu choose the Options command to 
display the Configurations Options dialog. 

 
To activate the SB200 controlled impedance function ensure 
the Use Polar Si8000 License check box is ticked. 

Choosing the default materials library 
Users can choose which materials library the SB200 uses at 
start-up. Click the File Locations tab and use the Browse 
button to navigate to the library file. 

 

Choosing background and stackup layer colors 
Choose the Colours tab to change colors from their factory 
defaults. 
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Choosing finished dimensions 
The finished dimensions of layers in the stackup will vary from 
the initial dimensions as result of pressing and processing. 
Use the Finishing options to specify the pre/post processing 
factors to be used for the finished stackup. 

 

Specifying the default view and opening file 
Select the General tab to specify the default view, two or 
three-dimensional, and that the SB200 opens the last used 
file on start-up. 
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Creating a new stackup 
Stackups may be created using the Stackup Wizard or 
manually using the editing window. 

Using the Stackup wizard 

 
Stackup wizard button 

The Stackup Wizard guides the user through the process of 
creating complex stackups in only a few steps. Click the 
Stackup Wizard button or choose the Stackup Wizard 
command from the File|New sub menu. The stackup editing 
window is cleared and the Stackup Wizard is displayed. 

 
Stackup Wizard 

Using the Wizard the user can specify the layer count and 
build type, stackup materials, planes and drill types in a 
single operation. 

Electrical layer count 
Begin by specifying the electrical layer count — up to 64 
electrical layers may be specified. Choose the number of 
layers from the drop down list box. 

Build type 
Choose the build type (Foil or Core) from the drop down list 
box. Core builds contain only core materials; most builds will 
be foil builds — containing internal layers of cores with two 
outer cores. 
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Choosing stackup materials 
Note; if Core build type has been specified the Foil material 
control will be disabled. 

 
Add material button 

To include a foil layer click the Foil Add Material button; 
the library of foil materials is displayed. 
Choose the foil material from the list of materials available 
and click the Select Highlighted Material button; the 
material is added as a foil layer to the stackup. 

 
Repeat the procedure for prepreg and core materials and 
the (optional) solder mask layers. 
Use the Clear button to remove a layer from the stackup. 

 

Stackup materials selected 

Nominating power planes 
Use the drop down list box to specify that a plane should be 
a power plane. Select all planes as required. To remove a 
power plane from the list select the plane number from the 
list and click Remove. 

 

Layers 4 and 5 specified as power planes 

Adding drill information 
To add a drill information between electrical layer 1 and the 
last layer click the Through-Plated and Non-Through-Plated 
check boxes as required. 
With all build options specified click Apply to complete the 
stackup. The finished stackup appears in the stackup 
window. 
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Creating and editing stackups 
The SB200a allows the designer to add or edit stackup 
layers in any order, from top to bottom, bottom to top or from 
the center layer outwards. In this example we create a four 
layer stackup, starting at the center core layer and adding 
layers above and below. 

Adding layers to the stackup 

 
Display materials library 

Items added to the stackup are added from the currently 
open materials library. The SB200a opens Program 
Files\Polar\SB200\default.mlb if it exists; if a different library 
is required open it via the Materials Library command. 
Note: the SB200 does not ship with the default.mlb library. 
For this discussion open one of the two sample library files, 
SB200 inch.mlb or SB200 mm.mlb (stored in the Program 
Files\Polar\SB200\Samples folder at installation time for a 
default installation.)  
Caution: Consistency of units 
When defining dimensions for a stackup (for example, layer 
thicknesses) ensure that all measurements are defined 
using the same units (mils, mm, etc.) throughout the 
structure and its libraries. 
Note: the libraries supplied for these examples are 
preloaded with sample data only. 
Click File|New to clear the stackup screen and notes and 
information text areas. 
Click the File|Save Stackup or Save Project command to 
save the stackup or project. Users are recommended to 
save stackups or projects frequently during the stackup 
creation process to avoid data loss. Stackup files (.stk), 
project files (.sci ) and library files (.mlb) should be backed 
up to a secure location. 

Adding a core layer 

 Add Layer Material 
button 

Click the Add Layer Material button and choose 
Core…the Core library is displayed 

The Core library contains full details of the core material, 
including base and finished thicknesses, dielectric constant, 
and upper and lower copper thicknesses. 

 
Click on the column button to sort the library list by the 
selected column. 
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Choose a core type from the list of cores and click the Add 
Above button 

 
Add core above 
selected layer 

Add core above selected layer. The core is added to the 
stackup screen. 

 
Stackup core layer 

Layers may also be added below the selected layer.  

 
Add core below 
selected layer 

As each layer is added the stackup information table is 
updated to reflect the current status of the stackup. 

 

Stackup information table 

With the core selected, the Selected Item table displays the 
properties of the core. 

 

Core layer information 
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Editing the selected layer properties 
To change the properties of the selected object (for 
example, to modify the value for the finished thickness of the 
dielectric), right click the object in the stackup and choose 
Properties from the shortcut menu; the Core Properties 
dialog is displayed. 
Note: the on-screen descriptive text to the left of each layer 
is plain free form text derived from the layer properties and 
can be modified using the layer properties dialogs. 
When altering descriptions, keep the description short and 
avoid using dimensional information in text fields which 
produce on-screen display; if the dimensions specified in the 
dialog’s other text boxes are subsequently changed the on-
screen description may not match the true dimensions. 

 
Change the Dielectric finished thickness to the corrected 
value and click Apply. 

Adding data file names 
If available, add the data file name(s) to the upper and lower 
copper layers and click Apply. 
Close the dialog when all changes are completed. 
Changes will be reflected in the Stackup Information table 

Changing a layer function 

 
Set Layer Plane 

In this example we change both signal layers above and 
below the core dielectric to planes. 
Click the lower signal layer and click the Set Layer Plane 
button. Repeat for the upper signal layer.  
The changes are reflected in the stackup window 
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Exchanging layers 

 
Library Swap button 

To change just the core dielectric (leaving the copper 
layers unaffected) select the core material (for example the 
FR4 in the graphic above) and click the Swap Selected 
Material button. Choose the new core type from the library 
and click the Swap button. 
The layer properties will change to reflect the new material 
and changes appear in the Stackup Information table. 

Adding Prepreg layers 

 
Add Layer Material button 

With the core selected, click the Add Layer Material button 
and choose Prepreg…; the Add Prepreg library is 
displayed. 

 
The Prepreg library contains details of the Prepreg material, 
including the Prepreg’s base and finished thickness and 
dielectric constant.  

 
Add Prepreg Above 

Choose the Prepreg material from the database and click 
the Add Prepreg Above button. 

 
The Prepreg layer is added above the core. 
To change the properties of the prepreg material richt click 
the layer and choose Properties form the short cut menu. 
For example, modify the value for Finished Thickness to 
reflect the effects of the pressing process. 

 
Note: Using the Configuration Options, the SB200a user can 
specify finished thickness of prepreg materials as 
percentage of base material thickness when the prepreg is 
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pressed between a variety of layer types (e.g. (e.g. signal 
and plane layers, mixed and plane, etc.). The SB200a will 
apply the settings specified. 

 

 
Add Prepreg Below 

Click the Add Prepreg button to display the Add Prepreg 
library and click the Add Below button 

The layer of Prepreg is added below the core. 

 
Modify the properties as necessary. 

Adding a layer of copper foil 
Select the upper layer of Prepreg and click the Add Layer 
Material button and choose Foil to display the copper foil 
library. 

 
Choose the foil type and click Add Above, the copper foil 
layer is added above the selected Prepreg layer. 

 
Repeat the procedure for the lower Prepreg layer: select the 
lower Prepreg layer and add a layer of copper foil below the 
layer. 
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To alter the foil properties, right-click the foil layer and 
choose Properties. Using the Properties dialog the user can, 
for example, specify that the trace is shown inverted. 

 
Note the stackup is built symmetrically about the center 
layer. 

Adding solder mask layers 
With the upper layer of foil selected, click the Add Layer 
Material button and choose Soldermask to add a layer of 
LPI solder mask above the foil. Repeat the process for the 
lower foil layer. 

 

Adding the Ident layers 
Select the lower LPI soldermask layer and click the Add 
Layer Material button and choose Ident to add a layer of 
Screened Ident below the layer. The sample Ident library 
includes ink thickness and color 

 
Repeat for the upper layer. 

 

Adding drill information 
To add a drill information between layers click the Add Drill 
button; the Add Drill dialog is displayed. 
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Choose the first and second electrical layer numbers (layers 
1 and 4 in the example). 
Specify the drill type, mechanical or laser and whether 
through plated. 
Optionally, add the NC drill data filenames. 
Optionally, add the hole count, number of different hole 
sizes and the minimum hole size. Click Add and close the 
dialog. The drill information is added to the stackup. In the 
example we have added through plated and laser drill 
information. 
This completes the stackup; the finished stackup is shown 
below 

 

Completed stackup 

Deleting a layer 

 
Delete layer 

To remove a layer from the stackup select the layer and 
click the Delete button. 
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Copying layers 

 
Copy Material 

With layers defined it will often be found more convenient 
to copy an existing layer and paste it into the stackup than 
to create a new layer “from scratch”. Select the layer to be 
copied and click the Copy Material button. 
Click the layer nearest the destination location and choose 
Paste Above or Paste Below as appropriate 
Note: when modifying the stackup it may be necessary to 
redefine the drill information to reflect the changes. 

Moving layers 

 Move selected layer up 
one layer 

 Move selected layer 
down one layer 

To move layers within the stackup use the Move Up and 
Move down buttons. 
When a layer is moved it is exchanged with the layer above 
or below, respectively. 

Displaying the stackup in 2-dimensional view 

 
View 2D button 

To change the view of the stackup from its default 3-dimensional 
aspect, click the View 2D button. 

The stackup is displayed in 2-dimensional view. 

 
 

  
Display 3D button 

Click the View 3D button to restore the 3 dimensional 
view. 
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Design Rule Checking 
The SB200a includes facilities to check for errors in stackup 
design, such as layers placed in invalid order or 
asymmetrical structures. 
The Design Rule Checker (DRC) displays results in the 
DRC dialog. As each design rule is broken the SB200a 
increments the error count on the DRC tab. 

Viewing design rule errors 
Click the DRC tab to view errors. 

 
The Design Rule Checker checks include checking for: 
Two Adjacent Copper Layers 
Resin Coated Copper on Internal Layer 
External Prepreg 
Internal Solder Mask 
Internal Ident 
Internal Peelable Mask 
Symmetry : Different Material Types 
Copper not Balanced 
Users can choose to display all errors or to select from a 
combination of Design Errors, Symmetry errors and Copper 
balance errors; check the boxes as required. 
The errors shown in the dialog above correspond to the 
stackup structure below. Errors are highlighted in red. 
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Correcting design rule errors 
Users are strongly recommended to work through and 
correct errors in the order in which the errors are listed. 
In the example stackup one of the Prepreg layers is external 
to the layer of copper foil. This will result in three errors: the 
External Prepreg error, the Two Adjacent Copper Layers 
error and the Symmetry: Different material types error. 
Placing the Prepreg layer into its correct position in the stack 
will clear both errors. 
The Ident layer (normally the outermost layer) is located on 
an internal layer. 
Two layers of copper are adjacent (effectively a short circuit 
between copper layers). 
The stackup is built asymmetrically. 
Move the layers to their correct location in the stackup to 
correct errors. Note that clearing each error may clear other 
errors in the process. 
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Adding controlled impedance structures 
The SB200 incorporates the facility to add controlled 
impedance structures to a layer in the stackup. The SB200 
is integrated with the Polar Instruments Si8000 Controlled 
Impedance Field Solver so impedance values for a structure 
may be calculated at the click of a button. 
Structure parameters may be copied to the Si8000 for 
processing (for example by the Si8000 Goal Seeking 
function) and calculated values pasted back to the SB200 
for insertion into the stackup. 
In this example we add a controlled impedance structure to 
signal layer 4 of the sample stackup below. 

 

Sample stackup (showing signal layer 4 selected) 

Note that in this example layer 5 is a mixed signal/plane 
layer. Potential reference planes for signal layer 4 are 
therefore plane layer 2, mixed signal/plane layer 5 and plane 
layer 7. 

 
With layer 4 selected, click the Controlled Impedance tab. 
The Add Structure button is displayed. 

 

Click the Add Structure button, the Structure Control dialog 
is displayed containing the controlled impedance structures 
applicable to the selected layer in the stack. Choose values 
for the target impedance and tolerance. If necessary, resize 
the Structure Control dialog to view all structures. 
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Click the Single Trace, Differential or Broadside option 
button as appropriate (in this case, we choose Single 
Trace|Offset Stripline 1B1A). 
Note: Broadside only appears as an option where the signal 
trace is between two reference planes. When selecting 
Broadside structures it will be necessary to choose the 
second trace. 
 
Specify the values for Target Impedance and Tolerance. 

Choosing reference planes 
As there are multiple reference planes available (layers 2, 5 
and 7, it will be necessary to specify which planes to use for 
this structure. Click the Advanced button. 

 
Choose a reference plane from the list of available planes. 
In the example structure plane layer 2, mixed plane 5 and 
plane layer 7 are available for reference. 
Note: if plane layer 7 is chosen as reference, it will be 
necessary to take into account the electrical effects of mixed 
signal/layer plane 5. 
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In this example we choose mixed signal/plane layer 5. Press 
OK to confirm. 
Repeat for all structures to be added. Click Apply for each 
structure then click Done to finish. In this example we 
choose a single structure. 

 
The stackup window changes to reflect the selected signal 
layer and its associated reference planes. 
The applied structure is displayed in the Controlled 
Impedance pane 

 
The window displays the parameters of the controlled 
impedance structure. Fields shown "greyed out" are values 
derived from the choice of materials in the stackup. For this 
structure, enter appropriate values for lower and upper trace 
widths. 
 

 
Calculate button 

Click the Calculate button to display the impedance value 
of the structure with the current parameters. The 
parameters may then be varied to alter the value of the final 
impedance. In the example above the user can vary the 
trace width in order to approach the value of the target 
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impedance; other parameters are changed by modifying 
the stackup dimensions (for example, core thickness H1). 
Clicking Apply All in the Structure Control dialog adds a 
single instance of all structures matching the stackup layer 
and the chosen criteria; the user can then choose the 
structure producing the value nearest the target impedance 
and delete the structures that are not needed. Controlled 
impedance operations are performed via the Controlled 
Impedance toolbar. 

 
Controlled Impedance toolbar 

 Add controlled impedance structure to current layer 

 Delete structure from current layer 

 Clear all structures from current layer 

 Refresh and calculate impedance 

 Calculate structure 

 Display layer and 
Navigate through structures 
Changing parameter values 
Clicking the Calculate function yields a value for impedance. 
The user can now vary parameters (for example, the 
dielectric height) to yield a value for impedance closer to the 
target impedance. For this example, select the dielectric 
layer; click the Swap Selected Material button and choose a 
different core (ensure the same dimensional units are used 
throughout the structure) and click the Refresh and 
Calculate Impedance button. The impedance is recalculated 
to its new value. To arrive at a solution acceptably close to 
the target impedance, use the goal seeking function of the 
Si8000 to alter other parameters (in this case, upper and 
lower trace widths). 
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Goal seeking with the Si8000 QuickSolver 
The SB200 Stackup Design System is fully integrated with 
the Si8000 Controlled Impedance Quick Solver. The user is 
able to transfer stackup layer dimensions to the 
QuickSolver, solve for stackup parameters to produce the 
target impedance (or calculate that the target impedance is 
unachievable with the current values) then transfer the 
solved dimensions back to the SB200. 
Ensure the Si8000 is running and that the Si8000 units 
match the SB200 units. With the stackup parameters 
displayed in the Controlled Impedance window, click the 
copy to Si8000 button to transfer the current SB200 
parameters to the Si8000. Switch to the Si8000 and click the 
Paste from SB200 button to load the parameters into the 
associated Si8000 fields. 
For the example data below we seek a final value for 
impedance of 50 Ohms ; H1, Er1 and T1 are fixed. 

 

Si8000 parameter fields with SB200 data loaded 

Click the Upper Trace Width Calculate button to goal seek 
on trace width. The Si8000 returns values for trace width to 
produce 50 Ohms final impedance. 

 

Solved values for impedance 

Click the Copy to SB200 button, switch to the SB200 and 
click the Paste from Si8000 button to display the solved 
parameters for the target impedance. It may be necessary to 
round some dimensions (e.g. dielectric heights) to the 
nearest practical values and recalculate the impedance. 
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Using the SB200a materials libraries 

 
Materials Library 

The materials libraries allow designers to manage their own 
libraries of board materials. 
Click the Materials Library button to display the Materials 
Library window. 
When the SB200a is started the material library specified as 
the default materials library file (via Configuration 
Options|File Locations) is opened. 

 
Each library component type is accessible via its associated 
tab. Click on the Tab to view or edit the component type.  

Materials library toolbar 
The Materials Library is managed via its toolbar 

 

 Clear Materials Library 

  Open Materials Library 

  Save Materials Library 

 Import Material into the Library 
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Creating a new library 
To create a new library click the Clear Materials Library 
button; the library is removed from the library manager. Click 
the Save Materials Library button to create the new library. 
To have the library load as the SB200a starts, specify it as 
the default materials library file via Configuration 
Options|File Locations. 

Adding material to the library 
Caution: Consistency of units 
When defining dimensions, e.g. layer thicknesses, for a 
stackup ensure all measurements are defined using the same 
units (mils, mm, etc) throughout the structure and its libraries. 
Open the library to be modified. To add material types to a 
library click the associated component type tab; click into the 
empty record at the bottom of each list and enter the 
material details. To delete a record, click the record selector 
and press Delete. 

 

Importing material to the library 
The SB200 allows users to add existing material lists to its 
library; material data must be arranged in the format and 
order used by the SB200 library. Sample files in comma 
separated value format and Microsoft Excel spreadsheet 
and template formats suitable for importing to the SB200 are 
included in the SB200a|Material Library Import folder. Click 
the Materials Library button to open the Library, then click 
the Import button to open the Import dialog. 

 

Library Import dialog 
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Creating a new materials library 
Choose the Start New Library option and choose the field 
delimiter type. The library import function can accept files in a 
variety of formats, tab delimited, comma separated and Excel 
worksheet and template formats. Sections of the sample files 
included with the SB200 are shown below. 

 

Sample library file in Microsoft Excel format 

 

Sample library file in comma separated format 

Files for importing into the library must be in the above 
format, with columns in the correct order. Examine the 
sample files supplied for more information. (It may be helpful 
to export data files from the current system into Microsoft 
Excel and save in Microsoft Excel workbook or text file 
format.) 
Specify the delimiter if necessary and choose the file type 
(Foil, RCC, Prepreg, etc.) and click Apply. Choose the file 
from the list displayed in the Open dialog and click Open. 
Repeat the procedure for every file type; Click Done when 
all file types have been imported. Save the file as a .mlb 
library file. 

Adding material data to an existing library 
To add material data to an existing library, open the library 
and click the Import Material button 





 

FlexLM server-side installation  •  33 

FlexLM server-side installation 

This document describes a simple FlexLM server-side 
installation for the Polar SB200a. 
Full details of the FlexLM product capabilities are contained 
in the FlexLM User Manual or on the www.macrovision.com 
web site. 
Note: You will need to be logged into the server with 
Administrator privileges to perform this installation. 

Step 1 – Starting the installer 
Insert the installation disk into the CDROM drive of the 
server. Start the installer via Setup.exe on the supplied disk. 
This will create a folder on the server which by default is: 
C:\ProgramFiles\FlexLm\V9.2 

Step 2 – Running LMTOOLS 
Navigate to the folder created in Step 1 and run the 
LMTOOLS.exe program. 

 

LMTOOLS dialog box 

Step 3 – Creating the HOSTID file 
Select the System Settings tab. 
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LMTOOLS System Settings 

The System Settings page displays critical information about 
your selected server machine. 
Click the Save HOSTID Info to a File button. 
This will create a text file that you will need to email to: 
flexlm.support@polarinstruments.com  
Note: Please also include within the email the Company Name 
that you would like associated with the licence file. Failure to 
do this will result in a delay in issuing the licence. Once Polar 
Instruments has received and processed this information you 
will be returned a custom licence file by email. 
Note: Until the custom licence file is correctly installed on 
the server machine the SB200a software cannot be used. 
The custom licence file is allocated to the nominated server 
machine and cannot be used on any other server. 

Step 4 – Configuring the SB200a service 
Once you have received your custom licence file from Polar 
Instruments copy it to the same folder that currently contains 
LMTOOLS.exe. 
Select the Config Services tab 

 

Config Services tab 



 

FlexLM server-side installation  •  35 

In the Service Name dropdown enter the service name: 
Polar SB200a 
Use the three Browse buttons to select the lmgrd.exe file, 
the SB200A.lic file and the Polar SB200A.log file. 
Select the Use Services and Start Server at Power Up 
checkboxes. 

 

Polar SB200a

C:\Flex\lmgrd.exe

C:\Flex\SB200a.lic

C:\Flex\PolarSB200a.log

 

Config Services tab 

Before leaving this page select the Save Service button to 
store these settings. 

Step 5 – Starting the server 
Select the Start/Stop/Reread tab 

 

Polar SB200a 

Using license file: C:\Flex\SB200a.lic 

 

Start/Stop/Reread tab 

Select the Start Server button; this should be the only time 
that you are required to do this as this service will be now be 
run at the time of server start up. 
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Step 6 – Verifying the SB200a service 
Select the Service/Licence File tab 
This should now show the Polar SB200a Service. 

 

Polar SB200a 

 
Service/Licence File tab 

This completes the server side installation; please refer to 
the FlexLM User Manual for additional information. 

 


